EDRMS CONTENT MANAGER TIP 017

Moving Documents from LAN Folders to
EDRMS Content Manager and Document
Queues

Notes:

e Itis not recommended to save emails to a LAN for filing into EDRMS Content
Manager as changing the title of a saved email on your LAN will not update the
actual subject of an email and EDRMS CM automatically pulls the title of an email
from its subject line. If you must save to a LAN, ensure the subject line is updated
first before saving it so that there is no need to rename the email on your LAN.

Or if you already have emails saved to the LAN and need the title to be different
from the email subject line, then you can update the Title (Free Text Part) after
uploading into EDRMS CM.

e If using Numbers in the titles be aware that EDRMS CM sorts lexicographically so
you need to number items as 0001, 0002, ......0010, 0011, otherwise it will sort it this
way: 1,10, 11,12, 13, 14,15, 16,17, 18, 19, 2, 20, 21 etc.

Moving a Single Document:
1. Locate the E-folder in EDRMS Content Manager into which you want to move the
document. If you don't already have a folder, create one. If you are an End user,
ask an Information worker to create for you (Refer to TIP 005 Creating a Record)

2. Copy the Record Number of the folder from the View pane.

3. Locate the document on the LAN that you want to move. Right click, select Send
to, the HPE Content Manager.
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4. A New Document pop-up window appears. If you need to update the Title (Free
Text Part) you can do so now. Paste in the record number into the Folder field or
use the drop down to select a recently used folder or click the blue KwikSelect
folder to search for a folder to file within. Click OK.

Display and/or Modify Notes Contacts Additional
General Dates / Other Details Related Records

Title (Free Text Part) D70479316A _(_3_:_:_\1 t Terms & Acronyms

Folder | ARCS-00100-20/152922A ‘ ~ ._

Enclosed?

OK Cancel Help

Note: Updating the title here will not update the title of the actual document.

Moving Multiple Documents into One Folder:
1. Locate the E-folder in EDRMS Content Manager into which you want to migrate the
documents. If you don't already have a folder, create one. If you are an End user,
ask an Information Worker to create one.

2. Copy Record Number of the folder from the View pane.

3. Locate the folder or documents on the LAN that you want to move:

Check for sub-folders - migration must be done at the lowest folder level and
should not contain other folders in it. Please note: that too many nested folders
can cause an error if the file path length is too large. Move documents to a new
folder without sub-folders if this happens.

Select the folder and right click.

Select Properties. Review the number of documents in the folder (you can migrate
a maximum of 300 documents if you are moving them to a new e-folder, fewer
for folders with existing documents).

4. Set up EDRMS Content Manager: you will need to set up a default container in
order to move documents into EDRMS CM.

5. Select Options from the File Menu.
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6. On the Content Manager options popup, select Documents tab:

. Content Manager option LIL

Viewer | Document Store Caching | Email | Startup | Reporter
Locale I Appearance I Spelling I Search I Search Options
GIS Settings | Documents | Dropped Folders I Dropzone

Default record type
icz DoCUMENT]

Default Container

[ ]=]
| ARCS-06450-80/24012A - |- _

[] Confirm check in action before continuing

D Display data entry form when creating new records
|:|Display Document in Viewer When Processing I
If document is a Windows file:

[7] Delete document after it has been processed

Update style for an email message that has been processed

[ Update the email message with an 'In Content Manager' indicator -

Automatically remove offline record containers when they become ewty

[ oK | [ cancet | [ cetciobal | [ Hew |

e — — =,

7. The Default Record Type is the document type for your ministry. This should be
already populated with your ministry document type. Use the blue KwikSelect
folder to change if required.

8. In the Default Container field, paste the record number of the folder to which you
want to move the documents.

Ensure that the Confirm Check in Action before continuing box is unchecked. If
this box is checked, you will be prompted to confirm every record as it goes into
EDRMS Content Manager. Click OK.
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Send records to EDRMS Content Manager:

1. Right click on the LAN folder you want to migrate. Or highlight a selection of
documents within a folder that you want to migrate and then Right click.

2. Select Send To, HPE Content Manager.
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3. Click OK. The Process Documents in Folder window is displayed, with the records
listed that you want to migrate. The status column will show them with a status of

Draft.
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4. Tag all the records (from Search Tab, select Tag All)
5. Right click, Check In.

6. The records will be checked in and their status in the Process Documents in

Folder will have changed to Original.

7. Close the window once complete.
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Remove default container information:
1. In EDRMS Content Manager, select Options from the File menu.

2. On the Content Manager options popup, select the Documents tab.

3. Remove the record number* you entered in the Default Container field.

O

q Search Options Viewer Document Store Caching Email Startup k
| Locale Appearance Spelling Search
i Reporter Documents Dropped Folders Dropzone
! Default record type
1
1 ‘ CITZ DOCUMENT ‘v ™
[}
| Default Container

| ||

1 (] confirm check in action before continuing
|:| Display data entry form when creating new records

Display Document in Viewer When Processing
4. Click OK.

*If you do not perform this step, all future records you migrate will go to into this folder
until you change it or remove it.

Note:

Electronic Folders now have an automated part rule that closes the folder and creates a
new part after 300 documents have been added into it. Refer to Tip 006 Electronic Folders
and Parts for further information.

Document Queues
Link LAN folders to EDRMS with a Document Queue. This also allows for automatic filing of
documents added to a LAN folder that is connected to a queue. So anytime you put a
document into that folder it will be filed into EDRMS CM.

1. On the Home Tab, click New and choose Document Queue.

E 7 Content Manager

ﬁ HOME SEARCH VIEW

I E Save Copy Record
Delete

¥ Save and Clear

Mew
- Properties B. Reference
‘E Record
2 [&] Location ar

el

|E Document Queus |0Fd5

=+ Other cument Queue
[ M ' Create a new Docume
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2. Choose Windows Folder, click OK.

- Ewmdows ool

B Extended MAPI Folder

OK Cancel Help

3. On the New Document Queue popup, add a name for the queue under Name of
document queue and click on the blue Kwikselect folder beside Location field to
navigate to the folder on the LAN you want to file. You can leave the computer
number or remove it, depending on whether you use multiple computers.

B Mew Document Queue El@

General Options Filters  Access Controls  Motes

Mame of document queue

|Queue Up! ‘

Location

| \\SFRIDIR.BCGOV\U1TT\ZDRAKOSS\Profile\Desktop\zoe test | o

Accessible only from the computer:

| NH403829 |-

DAIIGW automatic processing of this document gueue
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4. Leave Allow automatic processing of this document queue unchecked unless
you want documents to be filed automatically into EDRMS CM when documents
are added to the LAN folder.

5. Now go to the Options Tab, Add the type of document you use in the Default
Record Type field and the record number of the E-folder you want the documents
to file into then check boxes as per below screenshot and finally choose No
synchronization under After processing each document field. Click OK.

B2 Document Queue - Queue Up >

General Options  Filters  Access Controls  Motes

Default record type

|cnz DOCUMENT |v -

Default container (folder/box)

| ARCS-00100-20/145122A | v |l

[]Automatically view the current document

When checking in all documents, ignore ariginal documents

When a document is being processed:
Check for internal links to other documents
[] Confirm check in action before continuing

If possible, suppress entry form when creating new records

After processing each document:

|N0 synchronization e

(8] Cancel Help

6. The Document Queues window will open in a new window, tag it and right click,
and select Process.

== Document Queues - Queue Up! - 1 Document Queue |

+ B2 Name ~ Machine Location

Tag All Ctrl+A

=] Queue Up! NH403829 lal:| VWSFPIDIR.BCGOVIU 7T

]
]
2 untagal Ctrl+U
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Copy Cirl+C
Mew 3

Copy Document Queue

Search 4
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7. A Process document queue window will open. Now Tag All documents, right click,
and select Check In. The documents will be checked into the correct folder and will
show Status as Original. Close the New queue window when complete.

B Document Queues - Queue Up! -1 Document Queue B Process document queue Queve Up! (Documents i... |

' Mame Type Size Date Status
Celebrating Global Accessib... Email Messana L
+' hd Moose Hide Campaign - Re... Email Mess Tag All Ctri+A Draft
Untag all Ctrl+U

Bl BE 28

Invert all tags

|8 Checkin |

8. Go to LAN folder and delete or remove the documents if you will be using this
folder again for this queue to avoid filing the documents again.

9. Anytime you want to run this queue, go to the Manage Tab, and click Document
Queues, find the queue you want to use.

E 7 Content Manager - [Process document queue Cueue

ﬁ HOME SEARCH WIEW MAMAGE

m. Favorite Classifications = @5 Document Queues =

E,ﬂ" Favarite Thesaurus Terms ~ Hﬂ Automated Part Rules

l!# Requests €
Records

Note:

If you have more than 300 documents to file from the LAN Folder the system will create a
new part and a popup will appear asking whether to put the next document into the latest
part as the previous one is now closed and will proceed to ask this for each document left
in the queue to file which can be onerous if you have lots of documents left to file

n

The selected container (folder/box) (SEUS-16000-20/10224~001) is not the latest part.
Please confirm which part you wish to use by selecting one of the options below, or press
CANCEL to make a different container (folder/box) selection.

@ Use the latest part:

SBUS-16000-20/10224~002: 201394 - FINANCIAL ASSISTAMCE GRANTS -
Grant program application files - [TEST] SMSERG Application Files

Use the earlier closed part:

SBUS-16000-20/10224~001: 201394 - FINANCIAL ASSISTANCE GRANTS -
Grant program application files - [TEST] SMSERG Application Files
Selecting a closed part is prevented by system settings.

Cancel Help
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There are two options to work around this:

1.

Remove the automated part rule on the target folder and process the queue. This
would mean that if you had 1000 documents to file, they would all be filed to a
single folder. You would then have to create a new part, add 300 documents to it,
then create a new part, add 300 more until each part has 300 documents in it. If you
need to continue filing to that same folder, you would have to then update the
queue to reflect the new part number, double check that the folder doesn’'t have a
part rule applied, and then follow the same process until that folder is no longer
required for filing, at which point you can close the last part.

OR

Run a count on the contained records in your target file in EDRMS CM prior to
processing your queue and have only the number of documents tagged (or in the
LAN Folder) to make up numbers to 300 prior to processing just so you can limit the
potential number of times that popup will appear.

If you have questions about this process, please contact EDRMS.Help@gov.bc.ca for further
assistance.
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